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When a user opens Terminal locally or connects to the computer remotely, the user 
sees the access warning you create. The following task must be performed by an 
administrator user. You can use any text editor.

To create a command-line access warning:
1 Open Terminal.

2 Enter the following command to create the /etc/motd file:

$ sudo touch /etc/motd

3 Enter the following command to edit the /etc/motd file:

$ sudo pico /etc/motd 

4 Enter in your access warning message.

5 Save changes and exit the text editor.

6 Open a new Terminal window to test changes.

Your access warning text appears above the prompt in the new Terminal window.
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5 Securing Accounts

Use this chapter to learn how to secure accounts by assigning 
user account types, configuring directory access, using strong 
authentication procedures, and by safely storing credentials.

Securing user accounts requires determining how accounts are used and setting the 
level of access for users.

When you define a user’s account you specify the information to prove the user’s 
identity, such as user name, authentication method (password, digital token, smart 
card, or biometric reader), and user identification number (user ID). Other information 
in a user’s account is needed by various services—to determine what the user is 
authorized to do and to personalize the user’s environment.

Types of User Accounts
When you log in to Mac OS X, you use a nonadministrator or administrator account. 
The main difference is that Mac OS X provides safety mechanisms to prevent 
nonadministrator users from editing key preferences, or from performing actions 
critical to computer security. Administrator users are not as limited as nonadministrator 
users.

You can further define nonadministrator and administrator accounts by specifying 
additional user privileges or restrictions.

The following table shows the access provided to user accounts.

User Account User Access

Guest nonadministrator Restricted user access (disabled by default)

Standard nonadministrator Nonprivileged user access

Managed nonadministrator Restricted user access

Administrator Full computer configuration administration

System administrator (root) Unrestricted access to the computer
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Unless you need administrator access for specific system maintenance tasks that 
cannot be accomplished by authenticating with the administrator’s account while 
logged in as a normal user, always log in as a nonadministrator user. Log out of the 
administrator account when you are not using the computer as an administrator. Never 
browse the web or check email while logged in to an administrator’s account.

If you are logged in as an administrator, you are granted privileges and abilities that 
you might not need. For example, you can potentially modify system preferences 
without being required to authenticate. This authentication bypasses a security 
safeguard that prevents malicious or accidental modification of system preferences.

Guidelines for Creating Accounts
When you create user accounts, follow these guidelines:
Â Never create accounts that are shared by several users. Each user should have his or 

her own standard or managed account.
Individual accounts are necessary to maintain accountability. System logs can track 
activities for each user account, but if several users share the same account it is 
difficult to track which user performed an activity. Similarly, if several administrators 
share a single administrator account, it becomes harder to track which administrator 
performed an action.

If someone compromises a shared account, it is less likely to be noticed. Users might 
mistake malicious actions performed by an intruder for legitimate actions by a user 
sharing the account.

Â Each user needing administrator access should have an administrator account in 
addition to a standard or managed account. 
Administrator users should only use their administrator accounts for administrator 
purposes. By requiring an administrator to have a personal account for typical use 
and an administrator account for administrator purposes, you reduce the risk of an 
administrator performing actions like accidentally reconfiguring secure system 
preferences.

Defining User IDs
A user ID is a number that uniquely identifies a user. Mac OS X computers use the user 
ID to track a user’s folder and file ownership. When a user creates a folder or file, the 
user ID is stored as the creator ID. A user with that user ID has read and write 
permissions to the folder or file by default.

The user ID is a unique string of digits between 500 and 2,147,483,648. New users 
created using the Accounts pane of System Preferences are assigned user IDs starting 
at 501. 
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It is risky to assign the same user ID to different users, because two users with the same 
user ID have identical directory and POSIX file permissions. However, each user has a 
unique GUID that is generated when the user account is created. Your GUID is 
associated with ACL permissions that are set on files or folders. By setting ACL 
permissions you can prevent users with identical user IDs from accessing files and 
folders.

The user ID 0 is reserved for the root user. User IDs below 100 are reserved for system 
use; user accounts with these user IDs should not be deleted and should not be 
modified except to change the password of the root user. 

If you don’t want the user name to appear in the login window of a computer, assign a 
user ID of less than 500 and enter the following command in a Terminal window:

sudo defaults write /Library/Preferences/com.apple.loginwindow Hide500Users 

-bool YES

In general, after a user ID is assigned and the user starts creating files and folders, you 
shouldn’t change the user ID.

One possible scenario in which you might need to change a user ID is when merging 
users from different servers onto a new server or cluster of servers. The same user ID 
might have been associated with a different user on the previous server.

Securing the Guest Account
The guest account is used to give a user temporary access to your computer. The guest 
account should be disabled by default because it does not require a password to log in 
on the computer. If this account is enabled and is not securely configured, malicious 
users can gain access to your computer without the use of a password. 

In security sensitive environments the guest account should remain disabled. If you do 
enable the guest account, enable parental controls to limit what the user can do. 
Whether or not the guest account itself is enabled, disable guest account access to 
shared files and folders by deselecting the “Allow guest to connect to shared folders” 
checkbox. If you permit the guest account to access shared folders, an attacker can 
easily attempt to access shared folders without a password. 

When you finish with this account, disable it by deselecting the “Allow guests to log 
into this computer.” This prevents the guest user account from logging into the 
computer.

For more information about parental controls, see “Controlling Local Accounts with 
Parental Controls” on page 64.
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Securing Nonadministrator Accounts
There are two types of nonadministrator user accounts: 
Â Standard user accounts, which don’t have administrator privileges and don’t have 

parental controls limiting their actions. 
Â Managed user accounts, which don’t have administrator privileges, but have active 

parental controls. Parental controls help deter unsophisticated users from performing 
malicious activities. They can also help prevent users from misusing their computer.

Note:  If your computer is connected to a network, a managed user can also be a user 
whose preferences and account information are managed through the network.

When creating nonadministrator accounts, restrict the accounts so they can only use 
what is required. For example, if you plan to store sensitive data on your local 
computer, disable the ability to burn DVDs.

Controlling Local Accounts with Parental Controls
You can set limits for users by using Parental Controls preferences. For example, you 
might want to prevent users from being able to install or uninstall software, or you 
might want to restrict access to specific administrator tools or utilities. The preferences 
can be set according to your environment.

The following screen shows Parental Controls that you can set to restrict accounts.
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To securely configure an account with parental controls:
1 Open System Preferences, then click Accounts.

2 If the lock icon is locked, click the lock icon and enter an administrator name and 
password.

3 Select the user account you want to manage with parental controls and select the 
Enable Parental Controls checkbox.

4 Click Open Parental Controls.

5 Click System.

You can enable Simple Finder, which restricts an account to using applications listed on 
the Dock. With Simple Finder enabled, users can’t create or delete files. Simple Finder 
also prevents users from changing their passwords. 

Enabling Simple Finder is not recommended, unless your computer is used in a kiosk-
like environment.

In the System pane you can specify the applications the user has access to by selecting 
the “Only allow selected applications” checkbox. Then you can select or deselect 
applications in the applications list.

When you install third-party applications, you can add them to this list. Disable third-
party applications unless the user needs to use such an application and can do so in a 
secure manner. Third-party applications might give a standard user some administrator 
abilities, which can be a security issue.

You can also prevent the user from administering printers, changing his or her 
password, burning CDs and DVDs, and modifying the Dock by deselecting associated 
checkboxes.

6 Click Content.

In the Content pane you can restrict the websites that users can view by selecting “Try 
to limit access to adult websites automatically” and you can customize the list of adult 
sites by clicking customize and adding the URL of sites to the “Always allow these sites” 
list or the “Never allow these sites” list.

You can also select Allow access to only these websites, which prevents a user from 
accessing any site not in the list. The list can be expanded by clicking the Add (+) 
button below the list of sites.

7 Click Mail & iChat.

In the Mail & iChat pane you can limit Mail and iChat to specific mail and iChat 
addresses in the “Only allow emailing and instant messaging with” list. To add users to 
the list, click the Add (+) button below the list.
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You can also require that mail addressed to a recipient not listed must have permission 
to be sent by selecting the “Send permission request to” checkbox and entering an 
administrator’s mail address. When a user attempts to send mail, the mail is sent to the 
administrator’s mail address for permission to be sent.

8 Click Time Limits.

In the Time Limits pane you can restrict the number of hours the computer is used 
during Monday through Friday or weekends by selecting the “Limit computer use to” 
checkbox and setting the number of hours.

You can also set the times the computer can be accessed by selecting “weekday 
Sunday through Thursday” or “weekends Friday and Saturday,” and setting a time 
range.

9 Click Logs.

In the Logs pane you can view a user’s activity on the web or a specific application, 
from the current day to an entire year. If you see an activity you want to prevent a user 
from using, select the activity and then click Restrict.

Securing External Accounts
An external account is a mobile account that has its local home folder stored on a 
volume in an external drive. When an external account logs in, Mac OS X only shows 
the external account that the user logged in with. The external user account cannot 
view other accounts on the computer.

External accounts require Mac OS X version 10.5 Leopard or later and an external or 
ejectable volume that is formatted as Mac OS X Extended format (HFS Plus). If you use 
an external account use FileVault to protect the content of your home folder in case 
your external volume is stolen or lost.

For information about external accounts, see User Management.

Protecting Data on External Volumes
By default a user’s home folder is not encrypted. If a user stores their home folder on an 
external volume using an external account, the user must secure the data on the 
external volume. To secure the external volume:
Â The volume must be able to process an external authentication, such as a PIN or 

smart card before it is mounted or readable.
Â The user’s home folder should use FileVault or other encryption mechanisms to 

secure the data.
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Securing Directory-Based Accounts
Directory-based account is an account is located on a directory server. A directory 
server contains user account records and important data for authenticating users. If 
your computer is connected to a directory server, you can add directory users to your 
computer and grant them access. You can restrict a directory user account by using 
Parental Controls.

Access to directory servers is usually tightly restricted to protect the data on them. 

Securing Administrator Accounts
Each administrator should have two accounts: a standard account for daily use and an 
administrator account for administrator access. Remember that the non-administrative 
account should be used for most daily activity, especially when accessing the network 
or Internet. The administrator’s account should be use only when absolutely necessary 
to accomplish administrative tasks. To secure administrator accounts, restrict the 
distribution of administrator accounts and limit the use of these accounts.

A user account with administrator privileges can perform standard user and 
administrator tasks such as:

Â Creating user accounts
Â Adding users to the Admin group
Â Changing the FileVault master password
Â Enabling or disabling sharing
Â Enabling, disabling, or changing firewall settings
Â Changing other protected areas in System Preferences
Â Installing system software
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The following screen shows an account enabled to be an administrator account.

Securing the System Administrator Account
The most powerful user account in Mac OS X is the system administrator or root 
account. By default, the root account on Mac OS X is disabled and it is recommended 
you do not enable it. The root account is primarily used for performing UNIX 
commands. Generally, actions that involve critical system files require you to perform 
those actions as root. 

If you are logged in as a Mac OS X administrator, you perform commands as root or by 
using the sudo command. Mac OS X logs actions performed using the sudo command. 
This helps you track misuse of the sudo command on a computer. 

You can use the su command to log in to the command line as another user. 
By entering su root, you can log in as the root user (if the root account is enabled). 
You can use sudo to perform commands that require root privileges. 
You should restrict access to the root account.

If multiple users can log in as root, you cannot track which user performed root actions. 

Do not allow direct root login because the logs cannot identify which administrator 
logged in. Instead, log in using accounts with administrator privileges, and then use the 
sudo command to perform actions as root. 

For instructions about how to restrict root user access in Directory Utility, open 
Mac Help and search for “Directory Utility.”
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You can also disable the root account by using an administrative account and the 
dsenableroot command. For example, the following command disables the root 
account.

$ dsenableroot -d

By default, sudo is enabled for administrator users. From the command line, you can 
disable root login or restrict the use of sudo. Limit the administrators allowed to use 
sudo to those who require the ability to run commands as root.

The computer uses a file named /etc/sudoers to determine which users can use sudo. 
You can modify root user access by changing the /etc/sudoers file to restrict sudo 
access to specific accounts, and allow those accounts to perform specifically allowed 
commands. This gives you control over what users can do as root. 

To restrict sudo usage, change the /etc/sudoers file:
1 As the root user, use the following command to edit the /etc/sudoers file, which allows 

for safe editing of the file. 

$ sudo visudo

2 When prompted, enter the administrator password.

There is a timeout value associated with sudo. This value indicates the number of 
minutes until sudo prompts for a password again. The default value is 5, which means 
that after issuing the sudo command and entering the correct password, additional 
sudo commands can be entered for 5 minutes without reentering the password. 

This value is set in the /etc/sudoers file. For more information, see the sudo and sudoers 
man pages.

3 In the Defaults specification section of the file, add the following lines.

Defaults timestamp_timeout=0

Defaults tty_tickets

These lines limit the use of the sudo command to a single command per 
authentication and also ensure that, even if a timeout is activated, that later sudo 
commands are limited to the terminal in which authentication occurred.

4 Restrict which administrators can run sudo by removing the line that begins with 
%admin, and add the following entry for each user, substituting the user’s short name 
for the word user:

user ALL=(ALL) ALL

Doing this means that when an administrator is added to the computer, the 
administrator must be added to the /etc/sudoers file as described, if the administrator 
needs to use sudo.

5 Save and quit visudo.
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For more information, enter man vi or man visudo in a Terminal window. For information 
about how to modify the /etc/sudoers file, see the sudoers man page.

Understanding Directory Domains
User accounts are stored in a directory domain. Your preferences and account 
attributes are set according to the information stored in the directory domain.

Local accounts are hosted in a local directory domain. When you log in to a local 
account, you authenticate with that local directory domain. Users with local accounts 
typically have local home folders. When a user saves files in a local home folder, the 
files are stored locally. To save a file over the network, the user must connect to the 
network and upload the file. 

Network-based accounts are hosted in a network-based directory domain, such as a 
Lightweight Directory Access Protocol (LDAP) or Network Information Service (NIS) 
directory. When you log in to a network-based account, you authenticate with the 
network-based directory domain. Users with network accounts typically have network 
home folders. When they save files in their network home folders, the files are stored 
on the server.

Mobile accounts cache authentication information and managed preferences. A user’s 
authentication information is maintained on the directory server but is cached on the 
local computer. With cached authentication information, a user can log in using the 
same user name and password (or a digital token, smart card, or biometric reader), 
even if the user is not connected to the network.

Users with mobile accounts have local and network home folders which combine to 
form portable home directories. When users save files, the files are stored in a local 
home folder. The portable home directory is a synchronized subset of a user’s local and 
network home folders. For information about protecting your home folder, see 
Chapter 7, “Securing Data and Using Encryption,” on page 129.
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Understanding Network Services, Authentication, and Contacts
You can use Directory Utility to configure your computer to use a network-based 
directory domain. Disable directory search services that are not used by deselecting 
them in the Services pane of Directory Utility (shown here).

You can enable or disable each kind of directory service protocol in Directory Utility.

Mac OS X doesn’t access disabled directory services, except for the local directory 
domain, which is always accessed.

In addition to enabling and disabling services, you can use Directory Utility to choose 
the directory domains you want to authenticate with. Directory Utility defines the 
authentication search policy that Mac OS X uses to locate and retrieve user 
authentication information and other administrative data from directory domains.

The login window Finder and other parts of Mac OS X use this authentication 
information and administrative data. File service, Mail service, and other services 
provided by Mac OS X Server also use this information.

Directory Utility also defines the contacts search policy that Mac OS X uses to locate 
and retrieve name, address, and other contact information from directory domains. 
Address Book can use this contact information, and other applications can be 
programmed to use it as well.

The authentication and contacts search policy consists of a list of directory domains 
(also known as directory nodes). The order of directory domains in the list defines the 
search policy. 

Starting at the top of the list, Mac OS X searches each listed directory domain in turn 
until it finds the information it needs or reaches the end of the list without finding the 
information.
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For more information about using Directory Utility, see Open Directory Administration.

Configuring LDAPv3 Access
Mac OS X Leopard primarily uses Open Directory as its network-based directory 
domain. Open Directory uses LDAPv3 as its connection protocol. LDAPv3 includes 
several security features that you should enable if your server supports them. Enabling 
every LDAPv3 security feature maximizes LDAPv3 security. 

To make sure your settings match your network’s required settings, contact your 
network administrator. Whenever possible, all LDAP connections should be configured 
to be encrypted using SSL.

When configuring LDAPv3, do not add DHCP-supplied LDAP servers to automatic 
search policies if you cannot secure the network the computer is running on. If you do, 
someone can create a rogue DHCP server and a rogue LDAP directory and then control 
your computer as the root user.

For information about changing the security policy for an LDAP connection or for 
information about protecting computers from malicious DHCP servers, see Open 
Directory Administration.

Configuring Active Directory Access
Mac OS X Leopard supports mutual authentication with Active Directory servers. 
Kerberos is a ticket-based system that enables mutual authentication. The server must 
identify itself by providing a ticket to your computer. This prevents your computer from 
connecting to rogue servers. 

Mac OS X Leopard also supports digital signing and encrypted packet security settings 
used by Active Directory. These setting are enabled by default.

Mutual authentication occurs when you bind to Active Directory servers.

If you’re connecting to an Active Directory server with Highly Secure (HISEC) templates 
enabled, you can use third-party tools to further secure your Active Directory 
connection.

When you configure Active Directory access, the settings you choose are generally 
dictated by the Active Directory server’s settings. To make sure your settings match 
your network’s required settings, contact your network administrator. 

The “Allow administration by” setting should not be used in sensitive environments. It 
can cause untended privilege escalation issues because any member of the group 
specified will have administrator privileges on your computer. Additionally, you should 
only connect to trusted networks.
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For more information about using Directory Utility to connect to Active Directory 
servers, see Open Directory Administration.

Using Strong Authentication
Authentication is the process of verifying the identity of a user. Mac OS X supports local 
and network-based authentication to ensure that only users with valid authentication 
credentials can access the computer’s data, applications, and network services.

You can require passwords to log in, to wake the computer from sleep or from a screen 
saver, to install applications, or to change system settings. Mac OS X also supports 
authentication methods such as smart cards, digital tokens, and biometric readers.

Strong authentication is created by using combinations of the following authentication 
dimensions:
Â What the user knows, such as a password or PIN number
Â What the user has, such as one-time-password (OTP) token or smart card
Â What the user is, such as a fingerprint, retina scan, or DNA sample

Using a combination of these dimensions makes authentication more reliable and user 
identification more certain.

Using Password Assistant to Generate or Analyze Passwords
Mac OS X includes Password Assistant, an application that analyzes the complexity of a 
password or generates a complex password for you. You can specify the length and 
type of password you’d like to generate.

You can choose from the following types of passwords:

Â Manual:  You enter a password and then Password Assistant gives you the quality 
level of your password. If the quality level is low, Password Assistant gives tips for 
increasing the quality level.

Â Memorable:  According to your password length requirements, Password Assistant 
generates a list of memorable passwords in the Suggestion menu.

Â Letters & Numbers:  According to your password length requirements, Password 
Assistant generates a list of passwords with a combination of letters and numbers.

Â Numbers Only:  According to your password length requirements, Password 
Assistant generates a list of passwords containing only numbers.

Â Random:  According to your password length requirements, Password Assistant 
generates a list of passwords containing random characters.

Â FIPS-181 compliant: According to your password length requirements, Password 
Assistant generates a password that is FIPS-181 compliant (which includes mixed 
upper and lowercase, punctuation, and numbers).
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For example, you can create a randomly generated password or a FIPS-181 compliant 
password that is 12 characters long.

The following screen shows Password Assistant.

You can open Password Assistant from some applications. For example, when you 
create an account or change passwords in Accounts preferences, you can use Password 
Assistant to help you create a secure password.

Using Kerberos
Kerberos is an authentication protocol used for systemwide single sign-on, allowing 
users to authenticate to multiple services without reentering passwords or sending 
them over the network. Every system generates its own principals, allowing it to offer 
secure services that are fully compatible with other Kerberos-based implementations. 

Note:  Mac OS X Leopard support Kerberos v5 but does not support Kerberos v4.

Mac OS X Leopard uses Kerberos to make it easier to share services with other 
computers. A key distribution center (KDC) server is not required to use Kerberos 
authentication between two Mac OS X Leopard computers. 
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When you connect to a computer that supports Kerberos, you are granted a ticket that 
permits you to continue to use services on that computer, without reauthentication, 
until your ticket expires. 

For example, consider two Mac OS X 10.5 computers named "Mac01" and "Mac02." 
Mac02 has screen sharing and file sharing turned on. If Mac01 connects to a shared 
folder on Mac02, Mac01 can subsequently connect to screen sharing on Mac02 without 
needing to supply login credentials again.

This Kerberos exchange is only attempted if you connect using Bonjour, if you navigate 
to the computer in Finder, or if you use the Go menu in Finder to connect to a server 
using the local hostname of the computer name (for example, computer_name.local). 

Kerberos is also used to secure the Back to My Mac (BTMM) service. For more 
information about using Kerberos with BTMM, see “Securing BTMM Access” on 
page 188.

Normally, after your computer gains a Kerberos ticket in this manner, keep the Kerberos 
ticket until it expires. However, if you want to manually remove your Kerberos ticket, 
you can do so using the Kerberos utility in Mac OS X.

To manually remove a Kerberos ticket:
1 Open Keychain Access (in /Applications/Utilities).

2 From the Keychain Access menu, choose Kerberos Ticket Viewer.

3 In the Kerberos application’s Ticket Cache window, find the key that looks like this: 

"yourusername@LKDC:SHA1..."

It is followed by a long string of alphanumeric characters.

4 Click "Destroy" to delete that key.

You can also use the kinit, kdestroy, and kpasswd commands to manage Kerberos 
tickets. For more information, see kinit, kdestroy, and kpasswd man pages.

Using Smart Cards
A smart card is a plastic card (similar in size to a credit card) or USB dongle that 
has memory and a microprocessor embedded in it. The smart card can store and 
process information such as passwords, certificates, and keys. 

The microprocessor inside the smart card can do authentication evaluation offline 
before releasing information. 

Before the smart card processes information, you must authenticate with the smart 
card by a PIN or biometric measurement (such as a fingerprint), which provides an 
additional layer of security.
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Smart card support is integrated into Mac OS X Leopard and can be configured to work 
with the following services:

Â Cryptographic login (local or network based accounts)
Â Unlock of FileVault enabled accounts
Â Unlock keychains
Â Signed and encrypted email (S/MIME)
Â Securing web access (HTTPS)
Â VPN (L2TP, PPTP, SSL)
Â 802.1X
Â Screen saver unlock
Â System administration
Â Keychain Access

For more information, see the Smart Card Setup Guide at www.apple.com/server/
macosx/resources/.

Using Tokens
You can use a digital token to identify a user for commerce, communication, or access 
control. This token can be generated by software or hardware. 

Some common tokens are the RSA SecurID and the CRYPTOCard KT-1 devices. These 
hardware devices generate tokens to identify the user. The generated tokens are 
specific to that user, so two users with different RSA SecurIDs or different CRYPTOCard 
KT-1s have different tokens.

You can use tokens for two-factor authentication. Two-factor refers to authenticating 
through something you have (such as a one-time-password token) and something you 
know (such as a fixed password). The use of tokens increases the strength of the 
authentication. Tokens are frequently used for VPN authentication.

Using Biometrics
Mac OS X supports biometrics authentication technologies such as thumbprint readers. 
Password-protected websites and applications can be accessed without requiring the 
user to remember a long list of passwords. 

Some biometric devices allow you to authenticate by placing your finger on a pad. 
Unlike a password, your fingerprint can never be forgotten or stolen. Fingerprint 
identification provides personal authentication and network access. 

The use of biometrics can add an additional factor to authentication by using 
something that is a part of you (such as your fingerprint).

http://www.apple.com/server/macosx/resources/
http://www.apple.com/server/macosx/resources/
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Setting Global Password Policies
To configure a password policy that can apply globally or to individual users, use the 
pwpolicy command-line tool. 

Global password policies are not implemented in Mac OS X; instead, password policies 
are set for each user account. 

You can set specific rules governing the size and complexity of acceptable passwords. 
For example, you can specify requirements for the following:

Â Minimum and maximum character length
Â Alphabetic and numeric character inclusion
Â Maximum number of failed logins before account lockout

To require that an authenticator’s password be a minimum of 12 characters and have 
no more than 3 failed login attempts, enter the following in a Terminal window:

$ pwpolicy -n /Local/Default -setglobalpolicy "minChars=12 

maxFailedLoginAttempts=3”

For advanced password policies, use Password Server in Mac OS X Server. You can use it 
to set global password policies that specify requirements for the following:
Â Password expiration duration
Â Special character inclusion
Â Mixed-case character inclusion
Â Password reuse limits

You can use pwpolicy to set a password policy that meets your organization’s password 
standards. For more information about how to use pwpolicy, enter man pwpolicy in a 
Terminal window.

Storing Credentials
Mac OS X includes Keychain Access, an application that manages collections of 
passwords and certificates in a single credential store called a keychain. Each keychain 
can hold a collection of credentials and protect them with a single password. 

Keychains store encrypted passwords, certificates, and other private values (called 
secure notes). These values are accessible only by unlocking the keychain using the 
keychain password and only by applications that are approved and added to the access 
control application list.

You can create multiple keychains, each of which appears in a keychain list in Keychain 
Access. Each keychain can store multiple values. Each value is called a key item. You can 
create a key item in any user-created keychain. 
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When an application must store an item in a keychain, it stores it in the keychain 
designated as your default. The default is named “login,” but you can change that to 
any user-created keychain. The default keychain name is displayed in bold.

Each item in a keychain has an Access Control List (ACL) that can be populated with 
applications that have authority to use that keychain item. A further restriction can be 
added that forces an application with access to confirm the keychain password.

The main issue with remembering passwords is that you’re likely to make all passwords 
identical or keep a written list of passwords. By using keychains, you can greatly reduce 
the number of passwords you need to remember. Because you no longer need to 
remember passwords for multiple accounts, the passwords you choose can be very 
complex and can even be randomly generated.

Keychains provide additional protection for passwords, passphrases, certificates, and 
other credentials stored on the computer. In some cases, such as using a certificate to 
sign a mail message, the certificate must be stored in a keychain. 

If a credential must be stored on the computer, store and manage it using Keychain 
Access. Check your organization’s policy on keychain use.

Due to the sensitive nature of keychain information, keychains use cryptography to 
encrypt and decrypt secrets, and they safely store secrets and related data in files.

Mac OS X Keychain services enable you to create keychains and provide secure storage 
of keychain items. After a keychain is created, you can add, delete, and edit keychain 
items, such as passwords, keys, certificates, and notes. A user can unlock a keychain 
with a single password and applications can then use that keychain to store and 
retrieve data, such as passwords.

Using the Default User Keychain
When a user’s account is created, a default keychain named “login” is created for that 
user. The password for the login keychain is initially set to the user’s login password 
and is unlocked when the user logs in. It remains unlocked unless the user locks it, or 
until the user logs out.

You should change the settings for the login keychain so the user must unlock it when 
he or she logs in, or after waking the computer from sleep.

To secure the login keychain:
1 Open Keychain Access.

2 If you do not see a list of keychains, click Show Keychains.

3 Select the login keychain.

4 Choose Edit > Change Password for Keychain “login.”

5 Enter the current password, and create and verify a password for the login keychain.
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After you create a login keychain password that is different from the normal login 
password, your keychain is not unlocked at login.

To help you create a more secure password, use Password Assistant. For information, 
see “Using Password Assistant to Generate or Analyze Passwords” on page 73.

6 Choose Edit > Change Settings for Keychain “login.”

7 Select “Lock when sleeping.”

8 Deselect “Synchronize this keychain using MobileMe.”

9 Secure each login keychain item.

For information, see “Securing Keychains and Their Items” on page 80.

Creating Additional Keychains
When a user account is created it contains only the initial default keychain named 
“login.” A user can create additional keychains, each of which can have different 
settings and purposes.

For example, a user might want to group credentials for mail accounts into one 
keychain. Because mail programs query the server frequently to check for mail, it is not 
practical for the user to reauthenticate when such a check is performed. 

The user could create a keychain and configure its settings, so that he or she is required 
to enter the keychain password at login and whenever the computer is awakened from 
sleep. 

He or she could then move all items containing credentials for mail applications into 
that keychain and set each item so that only the mail application associated with that 
credential can automatically access it. This forces other applications to authenticate to 
access that credential.

Configuring a keychain’s settings for use by mail applications might be unacceptable 
for other applications. If a user has an infrequently used web-based account, it is more 
appropriate to store keychain settings in a keychain configured to require 
reauthentication for every access by any application.

You can also create multiple keychains to accommodate varying degrees of sensitivity. 
By separating keychains based on sensitivity, you prevent the exposure of sensitive 
credentials to less sensitive applications with credentials on the same keychain.

To create a keychain and customize its authentication settings:
1 In Keychain Access, choose File > New Keychain.

2 Enter a name, select a location for the keychain, and click Create.

3 Enter a password, verify it, and click OK.

4 If you do not see a list of keychains, click Show Keychains.
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5 Select the new keychain.

6 Choose Edit > Change Settings for keychain “keychain_name,” and authenticate, if 
requested.

7 Change the “Lock after # minutes of inactivity” setting based on the access frequency 
of the security credentials included in the keychain.

If the security credentials are accessed frequently, do not select “Lock after # minutes of 
inactivity.”

If the security credentials are accessed frequently, select “Lock after # minutes of 
inactivity” and select a value, such as 15. If you use a password-protected screensaver, 
consider setting this value to the idle time required for your screensaver to start.

If the security credentials are accessed infrequently, select “Lock after # minutes of 
inactivity” and specify a value, such as 1.

8 Select “Lock when sleeping.”

9 Drag the security credentials from other keychains to the new keychain and 
authenticate, if requested.

You should have keychains that only contain related certificates. For example, you 
could have a mail keychain that only contains mail items.

10 If you are asked to confirm access to the keychain, enter the keychain password and 
click Allow Once.

After confirming access, Keychain Access moves the security credential to the new 
keychain.

11 Secure each item in the security credentials for your keychain.

You can also use the security and systemkeychain commands to create and manage 
your keychains. For more information, see the security and systemkeychain man 
pages. For information, see “Securing Keychains and Their Items” on page 80.

Securing Keychains and Their Items
Keychains can store multiple encrypted items. You can configure items so only specific 
applications have access. (However, you cannot set Access Control for certificates.)

To secure a keychain item:
1 In Keychain Access, select a keychain and then select an item.

2 Click the Information (i) button.

3 Click Access Control and then authenticate if requested.

4 Select “Confirm before allowing access.”

After you enable this option, Mac OS X prompts you before giving a security credential 
to an application.
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If you selected “Allow all applications to access this item” you allow any application to 
access the security credential when the keychain is unlocked. When accessing the 
security credential, there is no user prompt, so enabling this is a security risk.

5 Select “Ask for Keychain password.” 

After enabling this, you must provide the keychain password before applications can 
access security credentials. 

Enabling this is important for critical items, such as your personal identity (your public 
key certificates and the corresponding private key), which are needed when signing or 
decrypting information. These items can also be placed in their own keychains.

6 Remove nontrusted applications listed in “Always allow access by these applications” by 
selecting each application and clicking the Remove (–) button.

Applications listed here require the user to enter the keychain password to access 
security credentials.

Using Smart Cards as Keychains
Mac OS X Leopard integrates support for hardware-based smart cards as dynamic 
keychains where any application using keychains can access that smart card. A smart 
card can be thought of as a portable protected keychain.

Smart cards are seen by the operating system as dynamic keychains and are added to 
the top of the Keychain Access list. They are the first searched in the list. They can be 
treated as other keychains on the user’s computer, with the limitation that users can’t 
add other secure objects.

When you attach a supported smart card to your computer, it appears in Keychain 
Access. If multiple smart cards are attached to your computer, they will appear at the 
top of the keychain list alphabetically as separate keychains.

You can manually unlock and change the PIN using Keychain Access. When changing 
the PIN on your smart card it is the same as changing the password on a regular 
keychain.

In Keychain Access, select your smart card and unlock it by double-clicking it. If it is not 
unlocked, you are prompted to enter the password for the smart card, which is the 
same as the PIN. Enter the PIN and Keychain Access will bring up the PIN-protected 
data on that smart card.

For more information, see the Smart Card Setup Guide at www.apple.com/server/
macosx/resources/.

http://www.apple.com/server/macosx/resources/
http://www.apple.com/server/macosx/resources/
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Using Portable and Network-Based Keychains
If you’re using a portable computer, consider storing your keychains on a portable 
drive, such as a USB flash memory drive. You can remove the portable drive from the 
portable computer and store it separately when the keychains are not in use.

Anyone attempting to access data on the portable computer needs the portable 
computer, portable drive, and password for the keychain stored on the portable drive. 
This provides an extra layer of protection if the laptop is stolen or misplaced.

To use a portable drive to store keychains, move your keychain files to the portable 
drive and configure Keychain Access to use the keychains on the portable drive. 

The default location for your keychain is ~/Library/Keychains/. However, you can store 
keychains in other locations.

You can further protect portable keychains by storing them on biometric USB flash 
memory drives, or by storing portable drive contents in an encrypted file. 
For information, see “Encrypting Portable Files” on page 143.

Check with your organization to see if they allow portable drives to store keychains.

To set up a keychain for use from a portable drive:
1 Open Keychain Access.

2 If you do not see a list of keychains, click Show Keychains.

3 Choose Edit > Keychain List.

4 Note the location of the keychain you want to set up. 

The default location is ~/Library/Keychains/. 

5 Click Cancel.

6 Select the keychain you want set up.

7 Choose File > Delete Keychain “keychain_name.”

8 Click Delete References.

9 Copy the keychain files from the previously noted location to the portable drive.

10 Move the keychain to the Trash and use Secure Empty Trash to securely erase the 
keychain file stored on the computer.

For information, see “Using Secure Empty Trash” on page 148.

11 Open Finder and double-click the keychain file on your portable drive to add it to your 
keychain search list.
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About Certificates
A certificate is a piece of cryptographic information that enables the safe transfer of 
information over the Internet. Certificates are used by web browsers, mail applications, 
and online chat applications.

When you communicate with a secure site, the information exchanged with the site is 
encrypted. This protects your login information, credit card numbers, addresses, and 
other secure data.

In Mac OS X, certificates are part of your digital identity and are stored in your 
keychain. Keychain Access lets you manage your certificates and keychains.

Certificates are issued by trusted organizations, such as VeriSign, Inc. or RSA Data 
Security, Inc. When you go to a secure website, Mac OS X checks the site’s certificate 
and compares it with certificates that are known to be legitimate. If the website’s 
certificate is not recognized, or if the site doesn’t have one, you receive a message.

The validity of a certificate is verified electronically using the public key infrastructure, 
or PKI. Certificates consist of your public key, the identity of the organization, the 
certificate authority (CA) that signed your certificate, along with other data that may be 
associated with your identity.

A certificate is usually restricted for particular uses, such as digital signatures, 
encryption, use with web servers, and so on. This is called the “key use” restriction. 
While it’s possible to create one certificate for multiple uses, it’s unusual to make one 
for all possible uses. Creating a certificate for multiple uses is also less secure.

A certificate is valid only for a limited time; it then becomes invalid and must be 
replaced with a newer version. The certificate authority can also revoke a certificate 
before it expires.

If you need to send a certificate to someone, you can export it using Keychain Access, 
and then send it through email or by other means. Likewise, if someone sends you a 
certificate, you can add it to your keychain by dragging it onto the Keychain Access 
icon, or by using the Import menu in Keychain Access.

Creating a Self-signed Certificate
You can create a certificate using the Certificate Assistant in Keychain Access. The 
certificate you create is called a self-signed certificate. Self-signed certificates don’t 
provide the guarantees of a certificate signed by a certificate authority.

To create a self-signed certificate:
1 Open Keychain Access, located in the Utilities folder in the Applications folder.

2 Choose Keychain Access > Certificate Assistant > “Create a Certificate.”

3 Enter a name for the certificate, choose a type, and then click Continue.
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Â Self-signed root certificate: A self-signed root certificate is a root certificate 
authority that someone makes for immediate use as a certificate. Such certificates 
do not benefit from the security of certificate chains and certificate policies. Most 
computers do not accept a self-signed certificate unless their owner first tells them 
to, and some computers do not accept them under any circumstances. They are 
however easy and quick to make, and are often used for testing purposes in place 
of certificates signed by proper certificate authorities.

Â Leaf certificate: A leaf is a certificate signed by an intermediate or root Certificate 
Authority. A leaf certificate benefits from the security of certificate chains and 
certificate policies. A leaf is situated at the bottom of a certificate chain.

4 Select “Let me override defaults” if you want to manually specify the information in the 
certificate, such as key pairs, extensions, and encryption. 

5 Review the certificate and click Done.

Adding Certificates to a Keychain
Digital certificates are used to validate users and hosts on the Internet. When you 
receive certificates from the Internet, you can add them to your keychain for quick 
access to secure websites and other resources. Once a certificate is added, it can be 
used by other compatible applications.

To add a certificate to a keychain:
1 Drag the certificate file onto the Keychain Access icon or double-click the certificate file.

2 If you want to view the contents of the certificate before you add it, click View 
Certificates in the dialog, and then click OK when you are done.

3 Choose a keychain from the pop-up menu and click OK. 

4 If you’re asked to provide a name and password, type the name and password for an 
administrator user on this computer.

For Keychain Access to recognize a certificate file, it must have a file extension that 
identifies it as containing certificates.

The following types of certificates are recognized by Keychain Access:

Â PKCS12 DER encoded - extension .p12 or .pfx
Â PKCS7 DER or PEM encoded - extension .p7r, .p7b, .p7m, .p7c, or .p7s

If Keychain Access is open, you can add a certificate by dragging the certificate onto 
the Keychain Access icon in the Dock.

You can also add a certificate to a keychain by choosing File > Import in Keychain 
Access.
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6 Securing System Preferences

Use this chapter to set Mac OS X system preferences to 
customize system security and further protect against 
attacks.

System Preferences has many configurable preferences that you can use to customize 
system security. 

System Preferences Overview
Mac OS X includes system preferences that you can use to customize security. When 
modifying settings for one account, make sure your settings are mirrored on all other 
accounts, unless there is an explicit need for different settings.

You can view system preferences by choosing Apple > System Preferences. In the 
System Preferences window, click a preference to view it.

The following is the System Preferences screen:
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Some critical preferences require that you authenticate before you modify their 
settings. To authenticate, you click the lock (see the images below) and enter an 
administrator’s name and password (or use a digital token, smart card, or biometric 
reader). 

If you log in as a user with administrator privileges, these preferences are unlocked 
unless you select “Require password to unlock each System Preferences pane” in 
Security preferences. For more information, see “Securing Security Preferences” on 
page 112. 

If you log in as a standard user these preferences remain locked. After unlocking 
preferences, you can lock them again by clicking the lock.

Preferences that require authentication include the following:
Â Accounts
Â Date & Time
Â Energy Saver
Â Network
Â Parental Controls
Â Print & Fax
Â Security
Â Sharing
Â Startup Disk 
Â Time Machine

This chapter lists each set of preferences included with Mac OS X and describes 
modifications recommended to improve security.
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Securing MobileMe Preferences
MobileMe is a suite of Internet tools that help you synchronize data and other 
important information when you’re away from the computer.

In sensitive environments don’t use MobileMe. If you must store critical data, only store 
it on your local computer. You should only transfer data over a secure network 
connection to a secure internal server.

If you use MobileMe, enable it only for user accounts that don’t have access to critical 
data. It is not recommended that you enable MobileMe for administrator or root user 
accounts.

Leave the options disabled in the Sync pane of MobileMe preferences (shown below).
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Leave Registered Computer for synchronization blank in the Advanced settings of the 
Sync pane (shown below).

Leave iDisk Syncing (shown below) disabled by default. If you must use a Public folder, 
enable password protection.

To disable MobileMe preferences:
1 Open MobileMe preferences.

2 Deselect “Synchronize with MobileMe.”



Chapter 6    Securing System Preferences 89

 

3 Make sure there are no computers registered for synchronization in the Advanced 
settings of the Sync pane.

4 Make sure iDisk Syncing is disabled in the iDisk pane.

From the Command Line:

Securing Accounts Preferences
Use Accounts preferences to change or reset account passwords (shown below), to 
enable Parental Controls, or to modify login options for each account. 

You should immediately change the password of the first account that was created on 
your computer. If you are an administrator, you can change other user account 
passwords by selecting the account and clicking Change Password.

# -------------------------------------------------------------------

# Securing System Preferences

# -------------------------------------------------------------------

# Securing MobileMe Preferences

# -------------------------

# Disable Sync options.

defaults -currentHost write com.apple.DotMacSync ShouldSyncWithServer 1

# Disable iDisk Syncing.

defaults -currentHost write com.apple.idisk $USER_MirrorEnabled -bool no
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Note:  If you are an administrator, password policies are not enforced when you change 
your password or when you change an other user’s password. Therefore, when you are 
changing passwords as an administrator, make sure you follow the password policy 
that you set. For more information about password policies, see “Setting Global 
Password Policies” on page 77.

The password change dialog (shown below) and the reset dialog provide access to 
Password Assistant, an application that can analyze the strength of your password and 
assist you in creating a more secure password. For information, see “Using Password 
Assistant to Generate or Analyze Passwords” on page 73.

Consider the following login guidelines:

Â Modify login options to provide as little information as possible to the user. 
Â Require that the user know which account they want to log in with and the 

password for that account. 
Â Disable automatic login if enabled. 
Â Require that the user enter a name and a password, and that the user authenticate 

without the use of a password hint. 
Â Disable fast user switching if enabled—it is a security risk because it allows multiple 

users to be simultaneously logged in to a computer.

You should also modify login options to disable the Restart, Sleep, and Shut Down 
buttons. By disabling these buttons, the user cannot restart the computer without 
pressing the power key or logging in.
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To securely configure Accounts preferences:
1 Open Accounts preferences.

2 Select an account and click the Password tab; then, change the password by clicking 
the Change Password button.

A menu appears asking you to input the old password, new password, verification of 
the new password, and a password hint. 

3 Do not enter a password hint, then click the Change Password button.

4 Click Login Options. 

A screen similar to the following appears:

5 Under “Display login window as,” select “Name and password” and deselect all other 
options.
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From the Command Line:

Securing Appearance Preferences
One method to secure appearance preferences is to change the number of recent 
items displayed in the Apple menu to None. 

Recent items are applications, documents, and servers you’ve recently used. You access 
recent items by choosing Apple > Recent Items.

If intruders gain access to your computer, they can use recent items to quickly view 
your most recently accessed files. Additionally, intruders can use recent items to access 
authentication mechanisms for servers if the corresponding keychains are unlocked. 

Removing recent items provides a minimal increase in security, but it can deter 
unsophisticated intruders.

# Securing Accounts Preferences

# -----------------------------

# Change an account’s password. 

# Don’t use the following command on a computer that could possibly have

# other users logged in simultaneously.

sudo dscl . passwd /Users/$User_name $Oldpass $Newpass

# Make sure there is no password hint set.

defaults write /Library/Preferences/com.apple.loginwindow RetriesUntilHint 

-int 0

# Set the login options to display name and password in the login window.

defaults write /Library/Preferences/com.apple.loginwindow SHOWFULLNAME -

bool yes

# Disable Show the Restart, Sleep, and ShutDown Buttons.

defaults write /Library/Preferences/com.apple.loginwindow PowerOffDisable -

bool yes

# Disable fast user switching.

defaults write /Library/Preferences/.GlobalPreferences 

MultipleSessionEnabled -bool NO
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To securely configure Appearance preferences:
1 Open Appearance preferences.

A screen similar to the following appears:

2 Set all “Number of Recent Items” preferences to None.

From the Command Line:

Securing Bluetooth Preferences
Bluetooth allows wireless devices, such as keyboards, mice, and mobile phones, to 
communicate with the computer. If the computer has Bluetooth capability, Bluetooth 
preferences become available. If you don’t see Bluetooth preferences, you cannot use 
Bluetooth.

Note:  Some high security areas do not allow radio frequency (RF) communication such 
as Bluetooth. Consult your organizational requirements for possible further 
disablement of the component.

When you disable Bluetooth in System Preferences, you must disable Bluetooth for 
every user account on the computer. 

# Securing Appearance Preferences

# -----------------------------

# Disable display of recent applications.

defaults write com.apple.recentitems Applications -dict MaxAmount 0
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This does not prevent users from reenabling Bluetooth. You can restrict a user account’s 
privileges so the user cannot reenable Bluetooth, but to do this, you remove several 
important user abilities, like the user’s ability to change his or her password. For more 
information, see “Types of User Accounts” on page 61.

To securely configure Bluetooth preferences:
1 Open Bluetooth preferences.

A screen similar to the following appears:

2 Deselect “Bluetooth Power.”

From the Command Line:

Securing CDs & DVDs Preferences
To secure CDs and DVDs, do not allow the computer to perform automatic actions 
when the user inserts a disc. 

When you disable automatic actions in System Preferences, you must disable these 
actions for every user account on the computer. 

# Securing Bluetooth Preferences

# -----------------------------

# Turn Bluetooth off.

defaults write /Library/Preferences/com.apple.Bluetooth \ 

ControllerPowerState -int 0
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This does not prevent users from reenabling automatic actions. To prevent the user 
from reenabling automatic actions, you must restrict the user’s account so the user 
cannot open System Preferences. For more information on restricting accounts, see 
“Securing Nonadministrator Accounts” on page 64.

To securely configure CDs & DVDs preferences:
1 Open CDs & DVDs preferences.

A screen similar to the following appears:

2 Disable automatic actions when inserting media by choosing Ignore for each pop-up 
menu.

From the Command Line:

Securing Date & Time Preferences
Correct date and time settings are required for authentication protocols, like Kerberos. 
Incorrect date and time settings can cause security issues. 

# Securing CDs & DVDs Preferences

# -----------------------------

# Disable blank CD automatic action.

defaults write /Library/Preferences/com.apple.digihub 

com.apple.digihub.blank.cd.appeared -dict action 1

# Disable music CD automatic action.

defaults write /Library/Preferences/com.apple.digihub 

com.apple.digihub.cd.music.appeared -dict action 1

# Disable picture CD automatic action.

defaults write /Library/Preferences/com.apple.digihub 

com.apple.digihub.cd.picture.appeared -dict action 1

# Disable blank DVD automatic action.

defaults write /Library/Preferences/com.apple.digihub 

com.apple.digihub.blank.dvd.appeared -dict action 1

# Disable video DVD automatic action.

defaults write /Library/Preferences/com.apple.digihub 

com.apple.digihub.dvd.video.appeared -dict action 1
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You can use Date & Time preferences (shown below) to set the date and time based on 
a Network Time Protocol (NTP) server. 

If you require automatic date and time, use a trusted, internal NTP server.

To securely configure Date & Time preferences:
1 Open Date & Time preferences.

2 In the Date & Time pane, enter a secure and trusted NTP server in the “Set date & time 
automatically” field. 

3 Click the Time Zone button.

A screen similar to the following appears:
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4 Choose a time zone.

From the Command Line:

Securing Desktop & Screen Saver Preferences
You can use Desktop & Screen Saver preferences (shown below) to configure a 
password-protected screen saver to prevent unauthorized users from accessing 
unattended computers. 

You can use several authentication methods to unlock the screen saver, including 
digital tokens, smart cards, and biometric readers. 

You should also set a short inactivity interval to decrease the amount of time the 
unattended computer is unlocked. For information about requiring authentication for 
screen savers, see “Securing Security Preferences” on page 112.

# Securing Date & Time Preferences

# -----------------------------

# Set the NTP server.

cat >> /etc/ntp.conf << END server time.apple.com END

# Set the date and time.

systemsetup -settimezone $Time_Zone
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You can configure Desktop & Screen Saver preferences to allow you to quickly enable 
or disable screen savers if you move your mouse cursor to a corner of the screen, as 
shown below. (You can also do this by configuring Exposé & Spaces preferences.)

When you configure Desktop & Screen Saver preferences, you configure the 
preferences for every user account on the computer. 

This doesn’t prevent users from reconfiguring their preferences. You can restrict a user’s 
account privileges so the user cannot reconfigure preferences. Doing this removes 
several important user abilities, like the user’s ability to change his or her password. For 
more information, see “Types of User Accounts” on page 61.

To securely configure Desktop & Screen Saver preferences:
1 Open Desktop & Screen Saver preferences.

2 Click the Screen Saver pane.

3 Set “Start screen saver” to a short inactivity time. 

4 Click Hot Corners.

5 Set a corner to Start Screen Saver for quick enabling of the screen saver.

Don’t set a screen corner to disable Screen Saver.
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From the Command Line:

Securing Display Preferences
If multiple displays are attached to your computer, enabling display mirroring might 
expose private data to others. Having this additional display provides extra opportunity 
for others to see private data.

Securing Dock Preferences
You can configure the Dock to be hidden when not in use, which can prevent others 
from seeing the applications you have on your computer.

To securely configure Dock preferences:
1 Open Dock preferences.

The following screen appears:

2 Select “Automatically hide and show the Dock.”

# Securing Desktop & Screen Saver Preferences

# -----------------------------

# Set idle time for screen saver. XX is the idle time in seconds.

defaults -currentHost write com.apple.screensaver idleTime -int XX

# Set host corner to activate screen saver.

#wvous-bl-corner (bottom-left)

#wvous-br-corner(bottom-right)

#wvous-tl-corner (top-left)

#wvous-tr-corner (top-right)

defaults write /Library/Preferences/com.apple.dock.wvous-corner_code-corner 

-int 5

# Set modifier key to 0 wvous-corner_code-modifier

defaults write /Library/Preferences/com.apple.dock.wvous-corner_code-

modifier -int 0
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From the Command Line:

Securing Energy Saver Preferences
You can use the Energy Saver Sleep pane (shown in the procedure below) to configure 
a period of inactivity before a computer, display, or hard disk enters sleep mode. 

If the computer receives directory services from a network that manages its client 
computers and you computer is in sleep mode, it is unmanaged and cannot be 
detected as being connected to the network. To allow management and network 
visibility, configure the display and the hard disk to sleep, but not the computer.

You can require authentication by use of a password, digital token, smart card, or 
biometric reader to reactivate the computer (see “Securing Security Preferences” on 
page 112). This is similar to using a password-protected screen saver.

You can also use the Options pane to make settings depending on your power supply 
(power adapter, UPS, or battery). Configure the computer so it only wakes when you 
physically access the computer. Also, don’t set the computer to restart after a power 
failure.

To securely configure Energy Saver preferences:
1 Open Energy Saver preferences.

A screen similar to the following appears:

# Securing Dock Preferences

# -----------------------------

# Automatically hide and show Dock.

defaults write /Library/Preferences/com.apple.dock autohide -bool YES


